Oracle® Enterprise Single Sign-on Anywhere
Administrator Guide
Release 11.1.1.1.0
E15579-01

August 2009
# Table of Contents

Abbreviations and Terminology .............................................................. 2  
About Oracle Enterprise Single Sign-on On Anywhere ............................... 3  
Overview of Creating a Deployment Package ........................................... 4  
General Tab ......................................................................................... 6  
Options Tab ......................................................................................... 7  
  Install .............................................................................................. 7  
  Updates ............................................................................................ 8  
  Agent Settings .................................................................................. 8  
Generate Tab ......................................................................................... 9
## Abbreviations and Terminology

Following is a list of commonly-used abbreviations and terminology.

<table>
<thead>
<tr>
<th>Abbreviation or Terminology</th>
<th>Full Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Console</td>
<td>ESSO-LM Administrative Console</td>
</tr>
<tr>
<td>Agent</td>
<td>Logon Manager</td>
</tr>
<tr>
<td>FTU</td>
<td>First Time Use Wizard</td>
</tr>
<tr>
<td>ESSO-AM</td>
<td>Oracle Enterprise Single Sign-on Authentication Manager</td>
</tr>
<tr>
<td>ESSO-Anywhere</td>
<td>Oracle Enterprise Single Sign-on On Anywhere</td>
</tr>
<tr>
<td>ESSO-PG</td>
<td>Oracle Enterprise Single Sign-on Provisioning Gateway</td>
</tr>
<tr>
<td>ESSO-KM</td>
<td>Oracle Enterprise Single Sign-on Kiosk Manager</td>
</tr>
<tr>
<td>ESSO-LM</td>
<td>Oracle Enterprise Single Sign-on Logon Manager</td>
</tr>
<tr>
<td>ESSO-PR</td>
<td>Oracle Enterprise Single Sign-on Password Reset</td>
</tr>
</tbody>
</table>
About Oracle Enterprise Single Sign-on On Anywhere

Oracle Enterprise Single Sign-on On Anywhere (ESSO-Anywhere) is the latest innovation in portable single sign-on (SSO) technology, enabling deployment of Oracle Enterprise Single Sign-on Logon Manager (ESSO-LM) and other Agents to end users’ desktops.

Using the ESSO-Anywhere Console, the administrator creates a deployment package configured with the Oracle products needed by users of an enterprise, making the package available over a Web server or file share. Users download this deployment package from an HTML interface that is included with the ESSO-Anywhere package, and which the administrator customizes. Users can then perform installations of the Oracle product suite on their own workstations at the click of a button, with assurance that configurations are correct and ready to run, and without administrator intervention.

**Note:** ESSO-Anywhere is designed for compatibility with Windows Authenticator v1. It is not designed to work with ESSO-LM features that require installing system services or GINAs, adding registry entries outside of Live HKLM\Software\Passlogix, or additions to Program Files or Windows system folders.

The deployment package must include ESSO-LM and might include either or both of the following Agents:

- Oracle Enterprise Single Sign-on Authentication Manager (ESSO-AM)
- Oracle Enterprise Single Sign-on Provisioning Gateway (ESSO-PG).

The Visual C++ Runtime Library and .NET 2.0 Framework are prerequisites for running ESSO-Anywhere. The installation package includes the Visual C++ Runtime Library, however you must make the .NET 2.0 Framework available to users. See the ESSO-Anywhere Release Notes for a complete list of software and hardware requirements.

**Note:** The final output of the deployment package is not an .MSI file. You must ensure that you supply any additional requirements that your end users will need to run their ESSO-LM and additional Agent software.

Due to security restrictions in Vista, you must change group policy settings in order for end users running Vista client to use the ESSO-Anywhere deployment package. See the Technical Notes section in ESSO-Anywhere Release Notes for more information.
Overview of Creating a Deployment Package

Following is the general procedure for creating a deployment package. Use the settings in the three tabs of the ESSO-Anywhere Console for your deployment configurations. See the help topic for each tab for an in-depth discussion of that tab's settings.

To create a deployment package:

1. Create a certificate file to be submitted when you generate the deployment package.
2. Install the ESSO-LM Administrative Console and Agent on a clean workstation.
3. Optionally, install additional Agents: ESSO-AM, and ESSO-PG.
4. Configure all Oracle products as you want them for deployment.
5. Make your ESSO-LM, ESSO-AM, and ESSO-PG configuration settings available to ESSO-Anywhere by doing one of the following:
   - To have ESSO-Anywhere import configuration settings from the local registry, write the Global Agent Settings to the registry;
   - To have ESSO-Anywhere import configuration settings stored in a .REG file, export your settings from the ESSO-LM Administrative Console to a .REG file. For more information, see the ESSO-LM Administrative Console Help file.

**Note:** Test your configuration before proceeding to create the deployment package.

6. Install the ESSO-Anywhere Console. ESSO-Anywhere reads the Oracle software configuration on the workstation where you installed it.
7. Verify in the **General** tab that the products and versions installed are the ones that you want to deploy.
8. From the **Options** tab, specify:
   - The deployment version and location, the installation location, and the installation type
   - The update schedule preferences
   - Which registry settings ESSO-Anywhere will use (the settings from the live registry, or the registry file you optionally created previously).

9. On the **Generate** tab:
   The ESSO-Anywhere Console creates a deployment package in the location you specified in the **Output folder** setting.
• In the Summary window, review all settings.
• Enter the directory path where the deployment package will be created, or click the **Browse...** button to navigate to the directory.
• Click the **Generate** button.
• At the prompt, enter the location for the certificate file that you created, and the password.

10. From the File menu, click **Save** or **Save As...** to save the deployment configuration settings.
11. Copy the deployment package to the virtual directory or file share that you specified in the Target location setting.
12. If deploying from a web server, customize the index.html file in the deployment directory, replacing the generic text with the information that you want end users to see.
13. If this is a first installation, notify users that the deployment package is available.
14. To create additional deployment packages, reconfigure settings on the ESSO-LM Administrative Console, and click **New** on the ESSO-Anywhere **File** menu.

**Note:** Users do not have the option to alter the installation. If you want different users to install different packages, create a separate deployment package for each installation.
General Tab

The two sections of the General tab contain information about the Oracle products installed on the workstation where you are creating the deployment package.

<table>
<thead>
<tr>
<th>Installed products</th>
<th>This section lists all Oracle products in the configuration. This list must contain ESSO-LM and might also include a combination of ESSO-AM and ESSO-PG.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File version</td>
<td>This section lists all components that were installed as part of the Oracle product installation, with their version numbers and installation locations. This information is the same as the information in the ESSO-LM &quot;About&quot; box.</td>
</tr>
</tbody>
</table>

![Image of Oracle Enterprise Single Sign-on Anywhere Console]
Options Tab

Use the Options tab to configure the settings for your deployment package.

![Options Tab](image)

Install

Use the settings in the Install group to configure the deployment version and file locations.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Deployment version</strong></td>
<td>Specify the four-field (x.x.x.x) version number of the deployment. It is your choice whether to match the deployment version to the version of ESSO-LM that you use for the deployment.</td>
</tr>
<tr>
<td><strong>Deployment type</strong></td>
<td>Specify whether ESSO-Anywhere will install on the local workstation. The Install Locally option creates a shortcut icon to ESSO-Anywhere in the user's Start menu and adds an entry for ESSO-Anywhere to the user's Add or Remove Programs applet on the Control Panel. The Online option is a per-session deployment and does not create the Start menu shortcut or add an entry to Add or Remove Programs. It also requires the user to have access to the web server or file share where the ESSO-Anywhere deployment package is located in order to run ESSO-Anywhere. The files will be cached on the user's machine, but the user cannot run the program directly.</td>
</tr>
<tr>
<td><strong>Target location</strong></td>
<td>Enter the virtual directory or file share from which ESSO-Anywhere will be distributed.</td>
</tr>
</tbody>
</table>
Updates

Use the settings in the **Updates** group to specify when ESSO-Anywhere should check for updates, and whether the user has the option to reject them when they are available.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check before the application starts</td>
<td>Check this box to have ESSO-Anywhere check for updates to any of the installed files before the application launches. ESSO-Anywhere updates only files that have changed.</td>
</tr>
<tr>
<td>Check at defined intervals</td>
<td>Check this box to specify a time interval at which ESSO-Anywhere checks for updates. Configurable intervals are from one hour to one year (52 weeks).</td>
</tr>
<tr>
<td>Specify a minimum required version</td>
<td>Check this box to enforce a minimum deployment version.</td>
</tr>
</tbody>
</table>

**Note:** If the user declines an optional update, ESSO-Anywhere does not offer that update again.

Localized Deployments

In order for localized installers and update notifications to appear in the correct language, you must have the appropriate .NET language pack installed on the workstation. To install a .NET language pack:

1. Log on to the local workstation.
2. Install the latest Microsoft .NET Framework if it is not already present (version 2.0 or above is required).
3. Download and install the target .NET language pack for your version of the .NET Framework.
4. Restart the workstation.
5. Install ESSO-Anywhere.
   The installer appears in the target language.

Agent Settings

Use the settings in the Agent Settings group to specify which registry settings ESSO-Anywhere should use.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live registry</td>
<td>Select to use the same settings as in the ESSO-Anywhere live registry.</td>
</tr>
<tr>
<td>Exported registry file (.REG)</td>
<td>Select to use a custom registry that you created in the Administrative Console and exported. If you select this option, click the <strong>Browse</strong>... button to direct ESSO-Anywhere to the desired registry file.</td>
</tr>
</tbody>
</table>
Generate Tab

Use the Generate tab to view a summary of your configuration settings, specify a location for your deployment output, and generate your deployment package.

<table>
<thead>
<tr>
<th><strong>Summary</strong></th>
<th>Review the settings in the <strong>General</strong> and <strong>Options</strong> tabs.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output folder</strong></td>
<td>Enter the path of the directory where you want to generate the ESSO-Anywhere deployment, or click the <strong>Browse...</strong> button to navigate to the desired directory.</td>
</tr>
<tr>
<td><strong>Generate</strong></td>
<td>After you review your settings and specify the location of the deployment package, click the <strong>Generate</strong> button to create the ESSO-Anywhere deployment package.</td>
</tr>
</tbody>
</table>

**Note:** Before distributing the deployment package, verify that it works correctly.

The ESSO-Anywhere installation includes a customizable index.html file. Edit this file with the information to direct end users to the deployment package, and distribute it.